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Finalizing A Presentation 1 
Reference Presentation File: New Products Division.pptx  

USING THE FILE MENU: INFO COMMAND 

The PowerPoint 2010 File menu: Info command offers a variety of options in 

finalizing a presentation.  These include converting the presentation into an earlier 

version, checking to see what changes in your 2010 file will not be supported by 

earlier versions, inspecting the document for any vulnerable personal or company 

information, and making a file read-only by marking the file final. 

File Properties Area 

1 
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1 
Finalizing A Presentation 

POWERPOINT 2010 FILE MENU: INFO COMMAND 



Microsoft PowerPoint 2010 Training For The Haas School of Business, UC Berkeley -  Dash Designs Consulting 

C
 H

 A
 P

 T
 E

 R
 

3 

 

POWERPOINT 2010 COMPATIBILITY CHECKER  

PowerPoint 2010 Compatibility Checker 

Each time you save a file in Office 2010 as a 97-2003 format (File: Save And 

Send button: Change File Type command) Microsoft runs the Compatibility 

Checker automatically to alert you to what formatting or functionality issues may 

arise when being viewed in the older versions. 

In addition, you can run the Compatibility Checker at any time by using the File 

menu: Info command: Check For Issues button 

The Compatibility Checker lists the number of occurrences and the slides on which 

those issues appear.  It does not provide any way to alter the data on the slides.  

However, this is mostly an informational tool.  Most of the issues revolve around 

not being able to view that particular formatting or not being able to edit that 

element when viewed in a 97-2003 application. 

Finalizing A Presentation 

1 
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PowerPoint 2010 Mark As Final 

Mark As Final Icon 

SECURING A POWERPOINT 2010 PRESENTATION WITH MARK AS FINAL 

Office 2010’s Mark As Final option prevents changes from being made to a 

“completed file”.  This marks the presentation as Read-Only.  When that 

presentation is opened, a Read-Only designation will appear in the Title Bar.  In 

addition, there will be a Mark As Final icon on the programs Window 

Frame (bottom left corner).   

This is an efficient method of securing accidental changes to a key presentation file. 

Mark As Final can be turned off by selecting the command from the Prepare Menu 

in the Office Button. 

1 
Finalizing A Presentation 
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Finalizing A Presentation 

1 

INSPECTING A PRESENTATION FOR NON-SECURE INFORMATION 

Using the File menu: Info command: Check For Issues button: Inspect 

Document command  allows you to use a tool to search for and remove personal 

and company data that you may not want to be seen by viewers outside your 

organization.  Some of this type of data may not be openly visible to you within the 

presentation.  This includes comments and annotations, document properties, off-

slide content, presentation notes, and personal information such as authorship. 

The Document Inspector has two phases.  First it scans the presentation for non-

secure types of data.  Then it reports its findings and displays options to remove 

that information. 

Once this data is removed, it can not be recovered so it might be a good practice to 

make a copy of the presentation and remove personal information from the copy.  

For example, if you remove all speaker notes from a presentation, then the original 

will no longer contain them. 

It is important to note that this is just one method of securing the presentation. 
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1 
Finalizing A Presentation 

INSPECTING A PRESENTATION FOR NON-SECURE INFORMATION 

Results of Document Inspector 

Remember, if you click the Remove All button that information 

will be permanently removed from the presentation file. 
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PowerPoint 2010 Save Options 2 
Reference Presentation File: New Products Division.pptx  

SAVE A PRESENTATION AS A 97-2003 FORMAT 

To share documents with users of previous versions of PowerPoint (excluding 

PowerPoint 2007) you must save your file in the 97-2003 Format.  The Office 

Button, Save As command contains a variety of formats in which to save a 

PowerPoint 2010 file.  Note that the option that does not show a version (i.e. 

PowerPoint Presentation) is the 2010 format. 

Microsoft will automatically run the Compatibility Checker to view issues of 

formatting and functionality as described in the previous section. 
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2 
PowerPoint 2010 Save Options 

SAVE A PRESENTATION IN PDF FORMAT 

One of the new features of Office 2010 is the ability to save a file in PDF format 

without using the full version of Adobe Acrobat.   

This option is located in the File menu: Save & Send command.   
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PowerPoint 2010 Save Options 

2 

MAKING A PRESENTATION VIEWABLE ONLY AS A SLIDE SHOW 

Presentations are generally saved as a .pptx file.  That is, as a normal PowerPoint 

presentation file.  However, another method to save a file and give it some level of 

protection is to save it as a .ppsx file, a PowerPoint Show file.  This option is 

available as a 97-2003 show as well (.pps).  The major benefit to creating a .ppsx 

file is that the viewer only needs to open the file outside of PowerPoint (i.e. double-

clicking the file in the folder it resides) to automatically start the Slide Show.  The 

viewer then doesn’t need to and can’t see the “inner workings” of the presentation. 

Steps: 

 Open the presentation 

 Click File menu: Save & Send command 

 Select the option for PowerPoint Show (*.ppsx) 

 Click the Save As button 

 Navigate to the preferred folder in which the file will be saved 

 Type a name for the presentation (if necessary) 

 Click Save 
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2 
PowerPoint 2010 Save Options 

MAKING A PRESENTATION VIEWABLE ONLY AS A SLIDE SHOW 

PowerPoint Show file in folder 

A PowerPoint Show Can Only Be Seen In Slide Show 
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PowerPoint 2010 Save Options 

2 

CREATING A VIDEO FROM A PRESENTATION 

PowerPoint 2010 has a new feature that allows you to create and save a video 

version of your presentation.  This can include slide timings, animations, and 

narration. 

This can be a great marketing and self-running version of your presentation. 

Note:  This can result in a much larger file size than with a normal 

presentation. 

Steps: 

 Open the presentation 

 Click File menu: Save & Send command 

 Select the option for Create A Video 

 Set any options necessary on the right side of screen 

 Click Create A Video 

 Navigate to the preferred folder in which the file will be saved 

 Type a name for the presentation (if necessary) 

 Click Save 
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2 
PowerPoint 2010 Save Options 

MAKING A PRESENTATION VIEWABLE ONLY AS A SLIDE SHOW 

A PowerPoint Video Viewed In Media Player 



Microsoft PowerPoint 2010 Training For The Haas School of Business, UC Berkeley -  Dash Designs Consulting 

C
 H

 A
 P

 T
 E

 R
 

13 

 

PowerPoint 2010 Publishing Options 3 
Reference Presentation File: New Products Division.pptx  

BROADCASTING A PRESENTATION ON THE WEB 

PowerPoint 2010 allows you to broadcast a presentation live on the web.  Viewers 

are sent a web address and can view the presentation from anywhere they have a 

web connection.   

A  Windows Live Systems ID and password are required for the creator of 

the presentation. 

Steps: 

 Open the presentation 

 Click File menu: Save & Send: Broadcast Slide Show command 

 Click the Broadcast Slide Show button 

 Log in (if necessary) with your Windows Live ID and password 

 In the Broadcast Show dialog box, click Start Broadcast 

 Click Copy Link or Send In Email to invite people to the broadcast 

 After sending email, click Start Slide Show 

 Present the slide show 

 When complete, click End Broadcast at the top of your screen 



C
 H

 A
 P

 T
 E

 R
 

14 Microsoft PowerPoint 2010 Training For The Haas School of Business, UC Berkeley -  Dash Designs Consulting 

 

3 
PowerPoint 2010 Publishing Options 

Broadcast Slide Show Dialog Box  

BROADCASTING A PRESENTATION ON THE WEB 

Windows Live Sign-In Screen 
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BROADCASTING A PRESENTATION ON THE WEB 

Sending Link To Broadcast Web Site via Email 

3 
PowerPoint 2010 Publishing Options 
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BROADCASTING A PRESENTATION ON THE WEB 

3 
PowerPoint 2010 Publishing Options 

Slide Show Broadcast in Viewers’ Web Browser 

End Broadcast Button 
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3 

PACKAGE A PRESENTATION FOR DISTRIBUTION 

The Package For CD command allows users to create a portable version of a 

presentation for distribution to clients and/or colleagues.  This process encapsulates 

the presentation with its own viewer so that PowerPoint is not required on that 

viewer’s computer.  It can be placed on a CD or a folder on a computer. 

This can make for a very efficient method of sending mailings to potential clients as 

well as a back up in the case of computer failure prior to a presentation. 

Steps: 

 Open the presentation 

 Click File menu: Save & Send: Package Presentation For CD 

 In the Package For CD dialog box, name the presentation 

TO PACKAGE THE PRESENTATION TO CD 

 Place a blank CD in the drive 

 Click Copy to CD button 

 If Microsoft asks about copying links, click No 

 When completed, click Close the Package For CD dialog box 

TO PACKAGE THE PRESENTATION TO A FOLDER 

 Click Copy to Folder button 

 If message appears about updating files to compatibility mode, click OK 

 Navigate to preferred folder in which packaged presentation will be saved 

 Click OK in Copy To Folder dialog box to confirm and process command 

 When completed, click Close the Package For CD dialog box 

PowerPoint 2010 Publishing Options 
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3 
PowerPoint 2010 Publishing Options 

PACKAGE A PRESENTATION FOR DISTRIBUTION 
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PowerPoint 2010 will ask in you want to include linked files in the “package”.  Click No to reduce 
the size of the file.  

Package For CD 

dialog box 

PACKAGE A PRESENTATION FOR DISTRIBUTION 

3 
PowerPoint 2010 Publishing Options 
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Copy To Folder dialog box 

PACKAGE A PRESENTATION FOR DISTRIBUTION 

Finished files on CD disc 

3 
PowerPoint 2010 Publishing Options 
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PowerPoint 2010 Publishing Options 

3 

CREATING HANDOUTS FROM MICROSOFT WORD 

Although PowerPoint provides options to print Handouts and Notes Pages, these 

options are limited.  Using the Create Handouts In Microsoft Word provides more 

options for layout and printing controls. 

This includes choosing layouts that are not available in PowerPoint. 

Steps: 

 Open the presentation 

 Click File menu: Save & Send: Create Handouts command 

 In the Send To Microsoft Word dialog box, select the preferred layout 

 Click Paste Link (if preferred) - updates Word document automatically 

 Save Word document to  

complete process 
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3 
PowerPoint 2010 Publishing Options 

CREATING HANDOUTS FROM MICROSOFT WORD 

Handouts in Microsoft Word Document 
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Customizing Slide Shows 4 
Reference Presentation File: New Products Division.pptx  

CREATE CUSTOM SLIDE SHOW 

A PowerPoint Custom Slide Show allows users to maintain one larger presentation 

file but choose which slides to present in the slide show.  This can be a flexible 

method in which to present different slide shows to groups all contained within one 

manageable presentation file. 

Steps: 

 Click on the Slide Show Tab 

 Click the Custom Slide Show command, 

Custom Shows option 

 In the Custom Show box, click the New button 

 In the Define Custom Show dialog box… 

 Type a name for the custom show 

 Double-click (or click Add button) to add preferred slides to right box 

 Click OK to complete the process 

 In the Custom Show box, click the Close button or Show button 
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4 
Customizing Slide Shows 

CREATE CUSTOM SLIDE SHOW 

Custom Shows dialog box 

Define Custom Show dialog box 
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Customizing Slide Shows 

4 

RUNNING A SLIDE SHOW WITH NARRATION 

Narrating a presentation allows presenters to communicate their “talking points” 
without having to be physically present during the presentation.  This is particularly 

useful when saving a file as a .pps format, allowing the viewer to see only the slide 

show with your voice-over.  Narrations can be embedded or linked (saving file 

size). 

PowerPoint tracks the time needed for each slide during the narration process and 

provides an option to save these timings along with the narration in order to play 

the presentation automatically if required. 

Steps: 

 Navigate to the starting slide 

 Click Slide Show tab: Record Slide Show  

 Select whether you want to include Slide and Animation timings and/or Narra-

tions and Laser Pointer options  

 Click Start Recording button 

 Start slide show and begin narrations 

 As you progress through each slide PowerPoint records narration as well as time 

allotment on each slide 

 At the end of the slide show PowerPoint will prompt you to Save or Don’t Save 
narrations and timings  

Reference Presentation File: PowerPoint Narration.pptx  
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4 
Customizing Slide Shows 

RUNNING A SLIDE SHOW WITH NARRATION 
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Customizing Slide Shows 

4 

REHEARSE AND APPLY TIMINGS FOR THE SHOW 

Slide Shows can be run automatically with timings you set (in seconds).  This can be 

done manually by entering a time in the Automatically After box in the Advance 

Slide group on the Transitions tab. 

You can also set timings by running the Rehearse Timings 

command on the Slide Show tab.  When you activate this 

command, the slide show automatically starts and records 

how many seconds have elapsed as you “talk through” each 
slide and you advance to the next slide.  At the end of the 

presentation, PowerPoint  will display the total time it took to 

complete the Slide Show and ask you if you want to assign the 

individual time settings to each slide. 

In the Set Up Show dialog box (see page 34), in the Advance Slides area, there is 

an option to run the slide show manually or “Using timings, if present.”  If you don’t 
change this option the Slide Show will run automatically from these timings. 

This is an excellent method to set up your Slide Show to run automatically as well as 

to get an estimate of how much overall time is required for your presentation. 

If you decide to change the timings, just run Rehearse Timings again. 

Steps: 

 Click Slide Show tab: Rehearse Timings  

 The Slide Show begins, “talk through” the first slide 

 When ready, click to advance to the next slide 

 Practice your presentation through each slide, advancing as necessary 

 At end of the slide show, click Yes to accept timings, if preferred 

Reference Presentation File: New Products Division.pptx  



C
 H

 A
 P

 T
 E

 R
 

28 Microsoft PowerPoint 2010 Training For The Haas School of Business, UC Berkeley -  Dash Designs Consulting 

 

4 
Customizing Slide Shows 

REHEARSE AND APPLY TIMINGS FOR THE SHOW 

Rehearse Timings In A PowerPoint Slide Show 

Applied Timings In Slide Sorter View 
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Customizing Slide Shows 

4 

APPLYING SLIDE SHOW SETUP OPTIONS 

Reference Presentation File: New Products Division.pptx  

The Set Up Show dialog box provides several options with which to control your slide 

show.  They include running the slide show continuously, running the slide 
show manually (with your mouse clicks) or 

automatically, and only showing a range of 

slides. 

This command is found in the Slide Show tab. 
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4 
Customizing Slide Shows 

USING PRESENTER VIEW 

PowerPoint 2010 has a new feature called Presenter View.  With this option a 

presenter can display their presentation on one display while seeing a different 

view on another.  For example, the presenter can display the actual slide show to 

the audience while viewing their speaker notes on another.   

This process requires two display devices. 

Steps: 

 Click Use Presenter View, in the Monitors group on the Slide Show tab 

 Click Check button to verify there are two displays 

 In the Display Monitors dialog box, click the Settings tab 

 Select the Use This Device As The Primary Monitor option 

 Click the 2nd monitor icon 

 Select Extend My Windows Desktop 

Onto This Monitor check box 

 Click OK 
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5 
Reference Presentation File: Insert Movies and Sounds.pptx  

INSERTING SOUNDS AND MOVIES INTO SLIDES 

Sounds and movies can be a powerful way of communicating information to the 

audience.  PowerPoint can read a variety of different movie and sound file formats.  

These include: 

Movies: .avi .mpg .mpeg    .wmv   .wpl 

Sounds: .wav .mdi .mp3 .aif 

The inserted movie appears as a still frame image.  An inserted sound appears as an 

icon.  Sounds and movies can be set to play on the click of the mouse or automatically 

when the slide appears on the screen during the slide show. 

Steps: 

Inserting Movies 

 Click onto the slide in which the movie will be inserted 

 Click the Insert tab: Media Clips group, Movie command  

 Select Movie from File (if an external file) - OR - 

 Select Movie from Clip Organizer  

(to use a PowerPoint animated graphic) 

 Choose one of the following options for how the movie will play 

Note: if you want to change the above options later, use the  

Custom Animation task pane and Effect Options box.  The Timing tab 

will allow you to reset how the movie starts. 

Advanced Slide Show Techniques 
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5 
Advanced Slide Show Techniques 

INSERTING SOUNDS AND MOVIES INTO SLIDES 

Steps: 

Inserting Sounds 

 Click onto the slide in which the movie will be inserted 

 Click the Insert tab: Media Clips group, Sound command  

 Select Sound from File (if the external file) - OR - 

 Select Sound from Clip Organizer  

(to use a PowerPoint sound file) 

 Choose one of the following options for how the movie will play 

Note: if you want to change the above options later, use the Custom Animation task 

pane and Effect Options box. 

The Timing tab will allow you 

to reset how the sound starts. 
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5 
Advanced Slide Show Techniques 

INSERTING VIDEO FROM DIRECTLY FROM THE WEB 

PowerPoint 2010 allows you to directly embed videos directly from the web.  In 

addition, you can easily edit your embedded videos with no additional software 
needed. Trim, add fades and effects, or even include bookmarks in your video to 

trigger animations. 

Note: Video can only be seen in the Slide Show View! 
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5 
Advanced Slide Show Techniques 

Steps: 

 On the Insert tab, open the Video button and select Video From Web Site... 

 Navigate to the website and find your video (i.e. YouTube).   

 Right-Click on video and select Copy embed html command. 

 Return to PowerPoint slide.   

 Click the Insert Tab, Video, Video from Web Site command.  

 Right-click and Paste copied html into the displayed dialog box  

 Click Insert. 

INSERTING VIDEO FROM DIRECTLY FROM THE WEB 
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Advanced Slide Show Techniques 

5 
Reference Presentation File: New Products Division.pptx  

USING AN ACTION BUTTON FOR SLIDE SHOW NAVIGATION 

You can create hyperlinks from Action Buttons to use during a Slide Show.  Action 

Buttons are graphic tools provided by PowerPoint. They come in a variety of shapes 

including left and right pointing arrow buttons.   Action buttons can be set to 

activate by clicking or just moving the mouse over them 

Action Buttons only operate during a Slide Show. 

Steps: 

 Navigate to the preferred slide 

 Click Insert tab, Shapes command 

 In the Shapes list, Action Buttons category, select preferred shape 

 

 

 

 

 

 

 

 Position the mouse over the slide and draw the shape on the slide 

 In Action Settings dialog box, activate Mouse Click or Mouse Over tab 

 Click the Hyperlink To option 

 Open the Hyperlink To list and select the option that best fits  

 Follow instructions in the succeeding screen 

 (i.e. select file to open, type or paste web address in URL box 

 Click OK until Action Settings dialog box is closed 
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Advanced Slide Show Techniques 

USING AN ACTION BUTTON FOR SLIDE SHOW NAVIGATION 

Action Settings Dialog Box - (Note: Mouse Click Tab and Mouse Over Tab) 

Action Settings Dialog Box - URL Option Dialog Box 
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USING AN ACTION BUTTON FOR SLIDE SHOW NAVIGATION 

Action Settings Dialog Box - Hyperlink To Other File Option Dialog Box 

Advanced Slide Show Techniques 

5 



C
 H

 A
 P

 T
 E

 R
 

38 Microsoft PowerPoint 2010 Training For The Haas School of Business, UC Berkeley -  Dash Designs Consulting 

 

USING AN ACTION BUTTON FOR SLIDE SHOW NAVIGATION 

Action Buttons On Slide Example 

5 
Advanced Slide Show Techniques 
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ANNOTATING SLIDE SHOWS 

During a presentation you may want to highlight or call attention to elements on 

the slide. 

You can add text or draw on a slide during the Slide Show using Annotation.  The 

Pen tool, available during the Slide show, allows you to emphasize your 

information by drawing on the slide.  This includes adding text, arrows, lines, as 

well as highlighting content. You can set the type and color of the pen in the 

Pointer Options menu during the slide show. 

The annotations will disappear when you change slides.  You can erase them at any 

time by pressing “E”.  At the end of the presentation you will have the option of 
keeping or discarding any remaining annotations. 

Advanced Slide Show Techniques 

5 

Steps: 

 Start the Slide Show 

 Right-Click anywhere on the screen 

 Select Pointer Options, then preferred type of annotation tool 

 Click Ink Color (to change color) 

 Move mouse over slide area and drag to create annotations 

Note: you can also move your mouse to the 

lower left corner of screen Click the Pen 

menu button 
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5 
Advanced Slide Show Techniques 

ANNOTATING SLIDE SHOWS 

Example of Annotations During Slide Show 

Notes: 

 You can erase annotations on an active slide by pressing the letter E key 

 You can turn off annotations by right-clicking on the screen during the slide show and 

selecting the Pointer Options, Arrow command 

 At the end of the slide show, PowerPoint will give you the option of discarding or 

keeping the annotations.  If kept, the annotations can be manually deleted on the slides 

themselves  
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5 
Reference Presentation File: Optional Advanced Project.pptx  

CREATING A CUSTOM SLIDE TO SLIDE TRANSITION 

Steps: 

 In Slide Sorter view, select the second of two consecutive slides 

 Copy and Paste the selected slide (Home tab) 

 here are now 3 slides 

 The 2nd slide should not have any transitions applied to it 

 Select slide 1, click Office button: Save As command 

 Set Save As Type box to jpg file type and name the file, click Save 

 Click the Current Slide Only button 

 Repeat for slide 2 

 Select slide 2 and draw a black rectangle over the entire slide  

 Insert the first picture created from the above steps onto slide 2 

 Resize picture so that it completely covers slide 2 

 Set the following Custom Animation effects for the 1st picture 

 Exit Animation = Collapse 

 Start = After Previous 

 Direction = Across 

 Speed = Fast 

 Insert the 2nd picture just as you did the 1st picture 

 Set the following Custom Animation effects for the 2nd picture 

 Entrance Animation = Stretch 

 Start = After Previous 

 Direction = Across 

 Speed = Fast 

 Set transitions for slides 2 and 3 to none and Automatically After to 0 seconds 

 Save presentation and run slide show 

Creating animated transitions in which slides appear to blend from one slide to the 

next is an interesting method of transitioning from one slide to another.   

Optional Project 
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5 
Advanced Slide Show Techniques 

CREATING A CUSTOM SLIDE TO SLIDE TRANSITION 


